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Intro
รู้จัก Sketchup
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SketchUp คืออะไร ?

SketchUp  คือ โปรแกรมส�ำหรับงำนสร้ำงโมเดล 3 มิติ ที่มีจุดเด่นต่ำงจำกโปรแกรมสร้ำงงำน 3 มิติทั่วไปคือ “ใช้

งำนง่ำย ท�ำงำนได้รวดเร็ว แม้ไม่เคยจับโปรแกรมประเภทนี้มำก่อน” 

คอนเซ็ปต์ในกำรท�ำงำนของ SketchUp จะเกิดจำกแนวคิดง่ำยๆ คือ เพียงแค่วำดเส้น 2 มิติลงไปแล้วดึงออกมำให้

เป็นรูปทรง 3 มิติ และท�ำแบบนี้วนต่อไปเรื่อยๆ ก็จะได้รูปทรง 3 มิติที่ซับซ้อนมำใช้งำนได้ในเวลำอันรวดเร็ว

โปรแกรม SketchUp ที่มี Interface หรือหน้าต่าง
โปรแกรมเรียบง่าย ดูเป็นมิตรกับผู้ใช้งาน

สำเหตุที่ SketchUp ได้รับควำมนิยมเป็นอย่ำงมำก นั่นเป็นเพรำะว่ำ ควำมง่ำยในกำรใช้งำนโปรแกรม เพียงแค่เรำ

เข้ำใจคอนเซ็ปต์กำรท�ำงำนที่กล่ำวไว้ เท่ำนี้ก็ถือว่ำเข้ำใจกำรท�ำงำนในโปรแกรมไปได้มำกกว่ำครึ่ง

ประวัติความเป็นมาของโปรแกรม
SketchUp เริ่มพัฒนำขึ้นโดยบริษัท @Last Software ในปี 1999 โดย Brad Schell และ Joe Esch เป็นผู้เริ่มต้น 

พัฒนำประมำณ 1 ปี หลังเริ่มพัฒนำสิงหำคมปี 2000 SketchUp ได้ออกสู่สำยตำประชำชนเป็นคร้ังแรกโดยยึด 

คอนเซ็ปต์ “3D for everyone” (3 มิติเพื่อทุกคน) และประสบควำมส�ำเร็จในเวลำรวดเร็ว ต่อมำวันที่ 14 มีนำคม 2006  

Google ได้เข้ำซื้อกิจกำรของ @Last Software โดยมุ่งเน้นให้ทีมพัฒนำของ @Last Software พัฒนำ Plugin ให้กับ

โปรแกรม Google Earth 

SketchUp ภำยได้กำรพัฒนำของ Google ในชื่อ Google SketchUp เป็นที่รู้จักอย่ำงกว้ำงขวำง Google ได้

พัฒนำ SketchUp ทั้งหมด 3 เวอร์ชัน
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1. SketchUp 6 เปดตัววันที่ 9 มกรำคม 2007 พร้อมติดตั้งโปรแกรมจัดหน้ำกระดำษอย่ำง Layout มำด้วยใน 

Version PRO 

2. SketchUp 7 เปดตัววนัที ่17 พฤศจกิำยน 2008 พร้อมคุณสมบติัใหม่ อย่ำงเช่น หน้ำต่ำงส�ำหรบัหำ Component 

จำก 3D Warehouse, LayOut 2 และ Dynamic components 

3. SketchUp 8 เปดตัว วันที่ 1 กันยำยน 2010 มีกำรปรับปรุงกำรท�ำงำน เช่น กำรใส่ขอมูลต�ำแหน่งโมเดลบน

แผนที่ Google (model geo-location with Google Maps) กำรใช้งำน Building Maker ในกำรช่วยสร้ำงโมเดลจำก

ภำพถ่ำยมุมสูงของ Google 

26 เมษำยน 2012 บริษัท Trimble ได้ติดต่อเจรจำขอซื้อ SketchUp จำก Google ทั้งสองบริษัทตกลงจะทํางาน

รวมกันในการทํางานและการสงเสรมิการพัฒนาของ SketchUp และ 3D Warehouse ใน 1 มถุินายน 2012 Trimble 

เสร็จสิ้นกำรเจรจำซื้อ SketchUp จำก Google และได้ออก SketchUp 2013 ในวันที่ 21 พฤษภำคม 2013 และเปลี่ยน 

Logo ของ SketchUp ใหม่

SketchUp LayOutStyle Builder              

ปจจุบัน SketchUp ออกเวอร์ชันใหม่ทุกปี

Download และติดตั้งโปรแกรม
โปรแกรม SketchUp สำมำรถ Download มำใช้งำนได้จำกเว็บไซต์ของ SketchUp เอง ด้วยกำรเข้ำไปที่เว็บไซต์

ดังกล่ำว แล้วท�ำงำนตำมขั้นตอนต่อไปนี้

01 เขา้ไปทีเ่วบ็ไซต http://www.

sketchup.com/ 

02 คลกิปุม Download Sketch-

Up เวบ็จะมคํีาถาม ระดบัการใชง้าน

โปรแกรมของท่านและเลอืกเวอรชนั

ทีม่คีวามเหมาะสมกบัการใชง้านให ้

หรือเลือกโปรแกรมตัวที่ต้องการ

ดาวนโหลด โดยคลิกที่ Products 

แล้วเลือก
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โปรแกรม SketchUp จะมีอยู่ 3 เวอร์ชันคือ SketchUp Pro, SketchUp Make และ SketchUp Viewer

SketchUp Make จะเป็นโปรแกรมที่สำมำรถดำวน์โหลดมำใช้งำนได้ฟรีๆ พร้อมกับควำมสำมำรถพื้นฐำนทั้งหมด 

คือ สำมำรถสร้ำงโมเดล 3 มิติได้, ก�ำหนดรำยละเอียดเพิ่มเติมให้โมเดล เช่น พื้นผิวหรือแสงและเงำได้ เรียกว่ำมีควำม

สำมำรถพอสมควรเหมำะส�ำหรับผู้ใช้งำนทั่วไป 

SketchUp Pro เป็นเวอร์ชันที่มีควำมสำมำรถอย่ำงเต็มรูปแบบส�ำหรับใช้ในกำรท�ำงำนระดับมืออำชีพจริงๆ เช่น 

กำรแลกเปลี่ยนไฟล์จำกโปรแกรมอื่นๆ หรือโปรแกรม Layout ที่เพิ่มเข้ำมำ ส�ำหรับกำรน�ำไฟล์ไปสร้ำงเป็นแปลน 2 มิติ 

ส�ำหรับพิมพ์หรือพรีเซนต์งำน กำรเปลี่ยนโปแรกรมมำใช้ SketchUp Pro จะต้องแลกมำด้วยกำรเสียค่ำใช้จ่ำยในกำรซื้อ

หรืออัพเกรดโปรแกรมขึ้นไปให้เป็นเวอร์ชันดังกล่ำว (รำคำ 595$)

SektchUp Viewer เป็นเวอร์ชันส�ำหรับกำรเปดดูไฟล์ SketchUp เท่ำนั้น ข้อดีคือประหยัดพื้นที่เก็บข้อมูล และ

เปดใช้งำนได้อย่ำงรวดเร็วเนื่องจำกโปรแกรมมีขนำดเล็ก

ถ้ำเลอืกดำวน์โหลด SketchUp Pro มำใช้งำน เรำจะได้โปรแกรมเวอร์ชนัทดลองใช้ ซึง่จะหมดอำยภุำยใน 

30 วัน (นับตั้งแต่ติดตั้งโปรแกรมลงในเครื่อง) แต่ถ้ำอยำกลองใช้งำนโปรแกรมเวอร์ชันนี้จริงๆ ก็โหลดมำ

ลองกันดูได้ เพรำะฟงก์ชันต่ำงๆ ในเวอร์ชัน Pro สำมำรถช่วยให้ท�ำงำนได้สะดวกและน่ำสนใจทีเดียว

03 กรอกข้อมูลท่ีทางเว็บไซต 

SketchUp ต้องการให้ครบ

04 คลิกปุม Download SketchUp Make และคลิกปุม บันทึกไฟลเพื่อ

ดาวนโหลดไฟลน้ันมากเก็บไว้ในเครื่อง ซ่ึงขั้นตอนนี้จะขึ้นอยู่กับโปรแกรม 

Web Browser ที่ท่านใช้
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หลังจำกดำวน์โหลดเรียบร้อยแล้วให้ดับเบิลคลิกไฟล์ที่ดำวน์โหลดมำเพื่อติดตั้งโปรแกรม เพียงเท่ำนี้ก็สำมำรถเริ่ม

ใช้งำน SketchUp ได้ทันที

Features นาสนใจในเวอรชันลาสุด
ใน SketchUp เวอร์ชันล่ำสุด ตัวโปรแกรมได้เพิ่มควำมสำมำรถใหม่ๆ เข้ำมำเพื่อให้สำมำรถท�ำงำนได้สะดวกข้ึน 

ไม่ว่ำจะเป็น

3D Warehouse

หน้าตาของโปรแกรม SketchUp เมื่อเปดขึ้นมาใช้งานครั้งแรก

»» A new look for 3D warehouse หน้ำตำของเวบ็ 3D warehouse 

ให้มีควำมสวยงำมมำกขึ้นและใช้งำนได้ง่ำยขึ้น 

»» WabGL Viewer สำมำรถดไูฟล์โมเดล 3 มิติท่ีอยูบ่น 3D warehouse 

ได้จำกหน้ำเว็บไซต์เลยได้ ไม่ต้องดำวน์โหลดมำเปดดูใน SketchUp เหมือน

แต่ก่อน
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»» Direct model upload สำมำรถอัพโหลดไฟล์ SketchUp ผ่ำน

หน้ำเว็บไซต์ได้เลย

»» Increased uploaded model size limit เพิม่ขนำดไฟล์ทีส่ำมำรถ 

อัพโหลดได้จำก 10 MB เป็น 50 MB

Interoperability
»» Classifier เป็นกำรระบุประเภทของวัตถุที่เรำสร้ำงข้ึนให้คอมพิวเตอร์ได้รู้ว่ำวัตถุที่เรำ

สร้ำงขึ้นมำนั้นเป็นอะไร เช่น เป็นเสำเข็ม ฐำนรำก พื้น เสำ ก�ำแพง หลังคำ เป็นต้น เพื่อรองรับ

กำรท�ำงำนในระบบ BIM

»» IFC Export เพิ่มควำมสำมำรถส่งออกไฟล์สกุล .IFC โดยไฟล์สกุลนี้ถูกใช้เป็นมำตรฐำน

ในกำรท�ำงำนร่วมกับโปรแกรมอื่นๆ ในระบบ BIM

»» Ruby 2.0  รองรับกำรพัฒนำ Plug in ต่ำงๆ บนมำตรฐำนภำษำ Ruby 2.0

3D Modeling & Performance
เพิ่มเครื่องมือในชุด Drawing เพื่อควำมสะดวกในกำรท�ำงำน

»» New Arc Tools เพิ่มเครื่องมือกำรสร้ำงเส้นโค้งแบบใหม่ ได้แก่ Arc, 3 Point Arc, Pie

»» Rotate Rectangular Tools เพิ่มเครื่องมือกำรสร้ำงสี่เหลี่ยมแบบใหม่ 

Documentation (LayOut) 
»» Auto text สำมำรถเพิ่มข้อควำมอัตโนมัติ เช่น วันที่แก้ไขเอกสำร เรียงเลขหน้ำกระดำษอัตโนมัติในโปรแกรม 

LayOut

»» Smart labels ป้ำยอัจฉริยะเหมือนกับใน SketchUp เมื่อเรำใช้ Leader ชี้ไปที่วัตถุใดๆ ก็จะปรำกฏข้อควำม

ในป้ำยให้เอง เช่น วัตถุที่ชี้ชื่ออะไร เป็นต้น

»» Improved vector rendering เพิ่มควำมสำมำรถในกำรแสดงผล เส้น Vector ใน LayOut ให้เร็วขึ้น
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ส�ำหรับ SketchUp 2016 ซึ่งเป็นเวอร์ชันล่ำสุดนั้นผู้ใช้จะพบกับควำมสำมำรถของโปรแกรมเพิ่มเติม ดังนี้

SketchUp Connected
SketchUp Connected ควำมสำมำรถในกลุ่มนี้ผู้ใช้งำนจ�ำเป็นต้องเชื่อมต่ออินเทอร์เน็ตไว้จึงจะสำมำรถใช้งำนได้

ควำมสำมำรถในกลุ่มนี้ ได้แก่

»» Trimble Connect เป็นระบบเกบ็ข้อมลูบนคลำวด์คอมพวิตงิของ SketchUp ท�ำให้ผูใ้ช้สำมำรถอพัโหลดไฟล์

งำนต่ำงๆ เก็บไว้บนเซิร์ฟเวอร์ และเรียกใช้งำนไฟล์ดังกล่ำวได้จำกทุกที่ที่สำมำรถเชื่อมต่ออินเทอร์เน็ตได้ ผู้ที่มีบัญชีผู้ใช้

ของ Google อยู่แล้วสำมำรถใช้บัญชีนั้น Login เข้ำใช้งำน Trimble Connect ได้เลย

»» Reload 3D Warehouse models ควำมสำมำรถนี้ท�ำให้ผู้ใช้สำมำรถใช้ค�ำส่ัง Reload เพื่อเปล่ียน 

Component จำก 3D warehouse ได้เหมือนกับไฟล์ที่อยู่ในเครื่องคอมพิวเตอร์ของเรำ

»» Generate Report 2.0 กำรใช้งำนค�ำสั่งนี้จ�ำเป็นต้องต่ออินเทอร์เน็ตไว้เช่นกัน โดยค�ำสั่งนี้จะท�ำให้ผู้ใช้งำน

สำมำรถดงึข้อมลูต่ำงๆ ทีฝ่งตัวอยู่ใน Component ออกมำสร้ำงเป็นรำยงำนให้เรำได้เลย ข้อมลูท่ีดึงออกมำได้ เช่น จ�ำนวน 

Component ในไฟล์งำน พื้นที่วัสดุหรือปริมำตรต่ำงๆ เป็นต้น คล้ำยกับกำรท�ำงำนของโปรแกรมที่มีระบบ BIM ทั่วไป

»» LayOut cloud references เป็นระบบที่ท�ำให้เรำสำมำรถดึงไฟล์ที่งำนที่เก็บอยู่บนคลำวด์คอมพิวติง อย่ำง 

Dropbox, Google Drive, และ Trimble Connect มำท�ำงำนและซิงค์ข้อมูลกันได้

การใชงานทั่วไปที่เปลี่ยนแปลง
»» Enhanced inferencing เพิ่มกำรล็อคแกนสีชมพูให้กับเครื่องมือต่ำงๆ โดยกดปุมลูกศรลง  �  เพื่อล็อค

แกนสีชมพู (แกนสีชมพูนี้เป็นแกนพิเศษที่จะปรำกฏขึ้มมำเมื่อเรำลำกเส้นขนำนหรือตั้งฉำกกับเส้นข้ำงเคียงที่เรำล่อไว้)

»» Customizeable utility trays on windows ผูใ้ช้ SketchUp บนเครือ่ง Windows จะพบกับไดอะล็อกบอ็กซ์ 

รูปแบบใหม่ที่อยู่ในรูป Trays แถบหน้ำต่ำง property ซ่อนอยู่ด้ำนข้ำงขวำมือของโปรแกรมเมื่อน�ำเมำส์ไปใกล้ๆ แถบ

หน้ำต่ำงก็จะเลื่อนออกมำ ท�ำเรำมีพื้นที่มำงำนมำกขึ้นไม่มีไดอะล็อกบ็อกซ์มำบดบังสำยตำเรำอีกต่อไป

»» Refreshed textures มีกำรเพิ่มและจัดเรียงกลุ่มวัสดุ Textures ใหม่
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นําเสนองานดวย 
Walkthrough และ 
Scene Animation
Scene Animation ใน SketchUp จะเปนการนาํเสนอ
งานในรูปแบบภาพเคลื่อนไหว โดยสามารถทําไดทั้ง
แบบ Avi ซึ่งเปนไฟลวิดีโอ หรือสราง Slide สําหรับ 
Present แบบ PowerPoint ก็ได
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Walkthrough และ Scene 
ใน SketchUp เราสามารถสร้างงาน Present Animation ได้จากการใช้งานชุดเครื่องมือ Walkthrough 

ร่วมกับค�าสั่ง Scene โดยเราจะใช้ชุดเครื่องมือ Walkthrough ในการเดินดูส่วนต่างๆ ในโมเดล และใช้ค�าสั่ง Scene 

สร้าง Scene ส�าหรับท�าเป็นแอนิเมชันขึ้นมา 

ใช้ชุดเครื่องมือ Walkthrough ร่วมกับ Scene สร้างมุมมองด้านต่างๆ ขึ้นมา หลังจากแสดง Scene ต่างๆ ต่อเนื่อง

กันก็จะได้งาน Present Animation

หากต้องการเลอืกมมุมองต่างๆ ของงานทีเ่ราสร้างข้ึน เพือ่ใช้ส�าหรบัในการน�าเสนองานทีเ่ราท�าในลกัษณะของการ

ตัง้ค่าไว้ล่วงหน้า เราสามารถท�าได้โดยการคลกิเมน ูWindow > Scenes ซึง่เมือ่เราสร้างหน้าใหม่โปรแกรมก็จะสร้างแถบ

การแสดงผลไว้ทีบ่รเิวณตอนบนจอภาพ ซึง่แต่ละแถบโปรแกรมจะเกบ็ค่าการแสดงผลต่างๆ ตามทีเ่ราเลอืกไว้ทัง้หมด เช่น 

มุมกล้อง รูปแบบการแสดงผล การเปด/ปดเลเยอร์ การแสดง แสงเงา เป็นต้น 
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3 Step สําหรับจําลองการเดินดวย Walkthrough
ชุดเครื่องมือ Walkthrough เป็นชุดเครื่องมือที่ใช้ส�าหรับเดินดูส่ิงต่างๆ ในโมเดล นอกจากก�าหนดให้เดินดูส่วน

ต่างๆ แล้ว เครื่องมือในชุดนี้จะรู้จักว่าตรงไหนเป็นผนัง ตรงไหนเป็นประตู ตรงไหนเป็นบันได ท�าให้การเดินไม่สามารถ

ทะลุผ่านส่วนดังกล่าวไปได้ และได้ผลลัพธ์เป็นการเดินดูโมเดลที่สมจริงที่สุด

การจ�าลองการเดินดูโมเดลด้วยชุดเครื่องมือ Walkthrough จะมีขั้นตอนการท�างานหลักๆ อยู่ 3 ขั้นตอนคือ

	 1.	วางต�าแหน่งกล้องลงไปในต�าแหน่งเริ่มต้นที่ต้องการ

	 2.	ก�าหนดทิศทางการมองว่าจะมองไปทางไหน ด้านบน ด้านล่าง ด้านซ้าย หรือด้านขวา

	 3.	เดินดูส่วนต่างๆ ที่ต้องการด้วยการแดรกเมาส์เลื่อนไปในทิศทางนั้นได้เลย

	วำงต�ำแหนงกล้องด้วย	Position	Camera
Position Camera เป็นเครื่องมือส�าหรับวางต�าแหน่งจ�าลองเหมือนวางตัวคนยืนลงไปในภาพ โดยหลังจากวาง

ลงไปแล้ว เราจะเห็นการมองภาพจากต�าแหน่งดังกล่าวในระดับสายตาคนปกติ

01	คลิกเคร่ืองมือ 
Position Camera

02	คลิกวางตำาแหน่งโดย

พยายามให้ลงที่ตำาแหน่งพื้น

03	ได้มุมมองจากตำาแหน่งที่กำาหนดในระดับสายตา

เครื่องมือในชุด Walkthrough สามารถเปดขึ้นมาใช้งานได้
โดยการคลิกเมนู View > Toolbars > Walkthrough
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	ก�ำหนดทิศทำงกำรมองด้วย	Look	Around
หลังจากวางต�าแหน่งกล้องด้วย Position Camera ไปแล้ว เราจะต้องก�าหนดทิศทางการมองให้เรียบร้อยเสียก่อน 

การก�าหนดทิศทางการมองท�าได้ด้วยการใช้เครื่องมือ Look Around  โดยมีขั้นตอนการท�างานต่อไปนี้

01	หลังจากวางตำาแหน่งด้วย Position Camera 

แล้ว โปรแกรมจะเรียกใช้เครื่องมือ Look Around โดย

อัตโนมัติ

02	คลิกค้างไว้แล้วเลื่อนไปในทิศทางที่ต้องการมอง

03	การมองจะเหมอืนยนือยูก่บัทีแ่ลว้หันมองไปรอบๆ

นารูเกี่ยวกับ Position Camera

 » หลังจากวางต�าแหน่งด้วย Position Camera แล้ว เราสามารถใช้เครื่องมือควบคุมมุมมองท�างานต่อได้ทันที 

 » การวางต�าแหน่งด้วย  Position Camera จะก�าหนดมุมมองจากระดับสายตาของคนปกติ ดังนั้น ควรจะท�างาน

ด้วยหน่วยที่ถูกต้องจึงจะเห็นผลลัพธ์ที่ตรงกับความเป็นจริง

 » ในกรณีที่วางต�าแหน่งผิดพลาดสามารถคลิกเครื่องมืออีกครั้งแล้ววางต�าแหน่งใหม่ได้ตามต้องการ

 » ส�าหรับงานที่ใช้เครื่องมือ Zoom หรือ Pan แล้วมองไม่เห็นภายในเพราะติดผนังบังอยู่ ให้ใช้ Position Camera 

วางต�าแหน่งการมองลงไปในห้องก็จะสามารถดูมุมมองภายในได้ตามที่ต้องการ
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	เดินดูสวนตำงๆ	ด้วยเครื่องมือ	Walk
เมื่อก�าหนดต�าแหน่งและทิศทางการมองเรียบร้อยแล้วก็ถึงเวลาที่จะออกเดินไปดูส่วนต่างๆ การเดินไปดูส่วนต่างๆ 

ท�าได้ด้วยการเปดเครื่องมือ Walk  ให้ท�างาน แล้วแดรกเมาส์เลื่อนไปยังทิศทางที่ต้องการเดิน

01	คลิกเครื่องมือ Walk

04	ลองเดินเข้าไปให้ถึงส่วนประตูทางเข้าจะพบว่า

ติดประตูไม่สามารถเดินต่อไปได้

02	คลิกคา้งไวแ้ลว้เลือ่นเมาส์ขึน้ลงเพือ่เดนิหน้าหรือ

ถอยหลัง

05	ให้  + แดรกเมาส์ เพื่อกำาหนดให้สามารถ

เดินทะลุกำาแพงหรือประตู

06	สามารถเดินเข้ามาด้านในได้ตามต้องการ

03	เลื่อนเมาส์ไปทางซ้ายหรือขวาเพื่อหมุนตัว

ในกรณีที่ต้องการหมุนดูรอบๆ ตัว หรือมองไปด้านอื่นๆ ขณะที่เดินสามารถท�าได้ด้วยการเปลี่ยนมาคลิก

เครื่องมือ Look Around แล้วหมุนดูรอบๆ ได้ทันที
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สรางงาน Present แอนิเมชัน
การสร้างงานแอนิเมชันใน SketchUp มีหลักการท�างานง่ายๆ คือ เราจะต้องสร้าง Scene ที่เป็นมุมมองด้านต่างๆ 

ขึ้นมา หลังจากนั้นจึงก�าหนดให้แสดงผลลัพธ์เป็นแอนิเมชันด้วยเมนู Play หรือ Export เป็นไฟล์วิดีโอ

ท�ำควำมรู้จักกับไดอะล็อกบ็อกซ	Scenes	
การสร้าง Scene ต่างๆ ตามต้องการท�าได้ด้วยการคลิกเมนู Window > Scenes หลังจากเปดไดอะล็อกบ็อกซ์

ดังกล่าวขึ้นมาแล้ว ในไดอะล็อกบ็อกซ์ที่เปดขึ้นมาจะประกอบไปด้วยส่วนต่างๆ ดังนี้

	 A.	Add Scene คลิกเพื่อสร้าง Scene ใหม่เพิ่มจะใช้ส�าหรับ
เพิ่มหน้าใหม่

	 B.	Delete Scene คลกิเพือ่ลบ Scene ทีเ่ลอืกออกไป 

	 C.	 Update Scene คลกิเพือ่ Update Scene ท่ีเลอืกด้วยต�าแหน่ง

มุมมองและข้อมูลล่าสุดที่ปรับแต่งใน Scene นั้น

	 D.	Move Scene Down และ Move Scene Up ใช้ส�าหรับสลับ

ต�าแหน่ง Scene ไปยังล�าดับก่อนหน้าหรือล�าดับหลังจาก Scene ที่

เลือก 

	 E.	 Include in animation จะเป็นการสัง่ให้ Scene ทีเ่ลอืกท�างาน

ถูกใส่ไว้ในการท�าแอนิเมชัน ถ้าหากไม่เลือกให้ท�างาน Scene ที่เลือก

จะถูกข้ามไปเมื่อสั่งให้ Play Animation

	 F.	 Name ก�าหนดชื่อ Scene 

	 G.	Description ก�าหนดข้อความแสดงรายละเอียดเพิ่มเติมให ้

Scene ที่เลือก

	 H.	Properties to save ก�าหนดข้อมลูทีต้่องการให้โปรแกรมบนัทกึ

ส�าหรับน�าไปท�าแอนิเมชัน เช่น ข้อมูลในส่วนของต�าแหน่งกล้อง หรือ

ข้อมูลจากการซ่อน/แสดงวัตถุ ปกติจะถูกเปดให้ท�างานหมดทุกช่อง

A
B

D

C

E

F

H

G

Options สําคัญสําหรับการเดินดวยเครื่องมือ Walk

 »  + แดรกเมาส์ จะเปลี่ยนเป็นการวิ่งแทนการเดิน

 »  + แดรกเมาส์ จะท�าให้เดินทะลุก�าแพงหรือผนังที่ทึบๆ ได้






